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How to Register Tasker

Thank you for your interest in Tasker! We've worked hard to get Tasker to perform the way 
that we think it should, and we hope that it increases your productivity.

Tasker is SHAREWARE, which means that you can try it for free for a period of 30 days.    If 
you use this software after the evaluation period, a registration fee of $19.95 is required or 
you must remove it from your computer.    The registration key will permanently unlock your
copy of Tasker, and you will receive future updates for FREE.    Thank you very much for your
support which allows us to continue enhancing this product!    We are sure that Tasker will 
save you much more than its cost in time savings.

There are two ways to purchase Tasker:    (“register” and “purchase” mean the same thing in
the shareware industry)

Option #1): Go to the Tasker website at http://www.vista-software.com/tasker.htm and 
register online with a credit card using PayPal    (the PayPal service is free and secure).    You
will receive a temporary registration key immediately to unlock Tasker, and a permanent 
registration key will be emailed to you within a few days.    At the Vista website there are 
volume discount options for corporations.

Option #2): Send a check for 19.95 US Dollars payable to:

Vista Software, Inc.
PO Box 93055
Phoenix, AZ    85070
USA

Your registration number will be emailed to you.    Please send us a notification email when 
you mail the check so that Vista Software can add you to the registered users’ database.

By registering Tasker, you will receive the following benefits:

· You will receive an instant Registration Key via email that will permanently unlock 
your copy of Tasker

· No more "Please Register" reminder screens will appear

· You will automatically receive future updates of Tasker and all bug fixes for FREE – a 
significant value, since Vista Software adds new features to Tasker on a regular basis

· Vista Software will notify you of new Tasker versions (but never any 
spam/promotional emails)

· You are ensuring that we can keep enhancing Tasker for the future versions

· You will feel good because you are doing the right thing and supporting the 
shareware "try before you buy" concept



Getting Started with Tasker

The purpose of Tasker is to make your computer automatically do your work for you.    This 
will allow you to do things that are tedious or time-consuming without actually doing them 
yourself. Computers are great for doing mundane tasks without complaining, and Tasker 
capitalizes on that ability.    Tasker accomplishes this goal by employing three methods:

1) Tasker can record computer actions and play them back

2) Tasker watches for special keys or text abbreviations as a signal to do something (such 
as automatically type for you)

3) Tasker can run script files to automate using direct commands

Of these three methods, #1 is the easiest and is demonstrated below.    Method #2 is very 
useful while typing documents, and after trying it, you will probably always want to have it 
activated.    The final method #3 is the most powerful application of Tasker and allows you to
automate complex tasks and create substantial solutions for many computer jobs.    To begin
using Tasker, you only need to see the basics in action with a short example.

Vista Software is confident that Tasker accomplishes computer task automation more easily 
and with a cleaner interface than any other macro program. If you have been using 
computers long enough, you may remember a program called "Recorder" that was included 
with Microsoft Windows version 3.1. Tasker operates under the same concept.

Here’s a step-by-step guide for the basics of Tasker:

1) Launch your other programs that you want to use ahead of time, such as Microsoft Word 
or Excel

2) Press the blue Record button on the Tasker toolbar:

3) Do what you want with the mouse and keyboard for a few seconds

4) Stop recording by pressing the red Stop button on the toolbar:

5) Replay what you did with the green Play button:



To stop the playback before it finishes, press the Control and Escape keys at the same time 
(this special keyboard combination immediately interrupts all playback and recording).    The
Control + Alt + Delete combination also stops a playback.



Obtaining Technical Support

There are lots of methods for obtaining help for using Tasker, and the references grow 
everyday with more user contributions.

The following options are currently available for obtaining Tasker help:

1) User  ’  s Guide (this file)  

Provides general information that concerns all Tasker users and does not contain 
anything that is too technical.    Most users should find answers to their basic 
questions in this help file.    It is in standard Windows .HLP (Help) format.

2) The Tasker website at www.vista-software.com/tasker.htm

This site can provide basic information about Tasker, including downloads, 
registration, the current production version number, and user reviews

3) “Help For This Screen”

Located on the Help menu, this feature provides context-sensitive help for the 
screen that you are currently using in Tasker. It describes every control or option 
that is available on the visible screen and why you would need to use it.

4) Script Reference

Contains documentation for the Tasker Script commands.    Using Tasker script is a 
very productive way to use Tasker and this file contains detailed descriptions and 
many examples that you can use.    This file is in HTML format.

5) Revision History

This file lists all the feature changes that have occurred during the development of 
Tasker.    It is useful for seeing what changes have transpired since the last version, 
or how long something has been included in Tasker.    Not every little thing gets into 
this file, since it is updated when time permits, but it is fairly comprehensive.    This 
file is in HTML format.

6) Frequently Asked Questions (FAQ)

Displays a list of the most common questions that users have when using Tasker.    
Questions like “Why does Tasker seem to play too slowly/too fast?” or “How can I 
press Ctrl+S with Tasker script?” are answered here.    This document is regularly 
updated, and is available on the web at www.vista-software.com/taskerfaq.htm.    
This file is in HTML format.

7) Legal Agreement

Contains the license agreement that you agreed to when installing Tasker.    It 
answers legal questions concerning the use of Tasker.



8) The “About Tasker” Dialog Box

Displays detailed information concerning the current version of Tasker that is 
installed on your PC.    It also shows the registration information, build date/time, 
copyright information, and hotlinks to Vista Software websites and support emails.

9) Tech Support Email

This is the most common method of technical support for questions that you can’t 
find answers to in the documentation listed above.    Vista Software usually answers 
within 24 hours.    Please provide a detailed description of your problem when 
sending questions.

Hey   –   where are the tech support phone numbers??  

Sorry, but there is no direct phone line that you can call for technical support.    With 
a sales price of only 20 dollars, it is not possible to have a dedicated phone support 
staff.    We promise that we will answer your emails as soon as possible (usually the 
same day, sometimes in a matter of hours).    We do understand what it’s like to not 
be able to directly call a vendor, but be assured we are committed to the Tasker 
product.    Vista Software is primarily a consulting firm, and we usually can’t be 
interrupted while working with clients (they don’t like that).    Of course, you could 
hire us to work with you on your next project, and then you can call us whenever 
you want to...



Script Overview

The Tasker Script Reference is not included with this document.    For a detailed 
reference on Tasker Scripts, please see the Script Reference which can be found in 
the Help Menu.    It is also available at 
http://www.vista-software.com/taskerscript.htm.

In addition to its recording capability, Tasker includes a very basic scripting language.    
“Script” is a text document that is comprised of code commands which Tasker understands.
Typically, Notepad is used to create and edit script files.    Any editor that can save in the 
Text Only format will work.    Tasker Script is very easy to learn and use, since it includes 
only five keywords:

CLICK
GOTO
START
TYPE
WAIT

Tasker is primarily a mouse and keyboard recorder which does not rely on a complex 
programming language, and script commands are meant to supplement your recordings. 
However, you may find that most tasks can be completed with simple script commands. You
can write a script for anything that you can type on your keyboard, including any movement
key (such as arrow keys) or any combination of keys (such as "Ctrl + V", "Alt + F", or "Shift
+ Ctrl + Left").

A typical script file will look like the one below.    To try this script, copy the text below and 
then paste it into Notepad.    Save the Notepad file as "C:\Test.tsx" (include the quotes) 
and then open and run “C:\Test.tsx” in Tasker.

; Launch the Notepad application
START notepad.exe

; Give Notepad a couple of seconds to appear
WAIT 2 seconds

; Switch to the Notepad application
GOTO Untitled - Notepad

; Press some keys and pause so the user can read it
TYPE Here is text that is being typed by Tasker {newline}{newline}Bye!
WAIT 2 seconds

; Show the File menu by using special characters (Alt + F)
TYPE {altdown}
TYPE f
TYPE {altup}
WAIT 2 seconds

; Show the System menu by clicking in the window corner
CLICK 10, 10



You can also save a recording as a .TSX Tasker Editable Text File (see the "Save As Type" 
option in the File Save As prompt).

Why would you use Tasker Scripts instead of just recording your actions? Sometimes it is 
easier to write a few lines of code rather than trying to get a perfect recording. In addition, 
a script file allows you to play back the commands back regardless of the computer's 
configuration (such as window placement), and even share the same script with other users.
This capability makes scripts better than regular recordings for teams (such as software 
testing projects). Finally, it is far easier to change a script file rather than re-record all of 
you actions for a lengthy process.

To programmatically control loops and playback speed with your scripts, please refer to the 
Command Line Parameters topic.

As mentioned above, the Tasker Script Reference is not included with this document.    For a 
detailed reference on Tasker Scripts, please see the Script Reference which can be found in 
the Help Menu   –   Advanced Help  .    It is also available at http://www.vista-
software.com/taskerscript.htm.



Command Line Parameters

Tasker Files (recordings and script files) accept command line parameters.    This feature 
allows you to run each file with unique settings instead of using the global options from the 
Tasker Playback screen.    There are three settings that can be controlled:    Speed, 
Repeats, and Continuous.    A description of each of these settings can be found in the 
Playback Tab help page.

Once these settings are used for running the Tasker File, they are not saved.    In other 
words, they will not apply to Tasker the next time that it starts up.

To customize the playback settings for a Tasker File, follow the instructions below:

NOTE: This feature is intended for advanced users only!

1) Create a shortcut to your file by creating a link to it on your desktop (or whatever folder 
you want it in)

2) Right mouse click on the Tasker File’s icon and choose Properties.    You should see a 
screen similar to the one below:



3) As displayed in the screen image above, add “/C” as the first parameter, then add any 
parameters that you wish to customize after the filename.    You can add /SPEED, 
/REPEATS, and /CONTINUOUS.    Each of these settings expects a number to follow it.

The /C parameter is required and must be the first parameter.
The /SPEED options are: 1=Slow;    2=Normal;    3=Fast;    4=As Fast As Possible.
The / REPEATS options are any positive whole integer
The /CONTINUOUS is a Boolean value expecting either a 1 or a 0

For a description of each of these settings, please refer to the Playback Tab help page.

The sample screen above shows a file called Task1.tsk that will run with the speed set to 
Fast, and it will loop for 10 times.

4) Run the file by double-clicking it, and it should run with your new settings.    The Tasker 
program itself will be unaffected by these settings.    You cannot use command line 
parameters to start Tasker with new settings – that must be done in the Playback Tab itself.



Playback Tab
 

Screen Item Purpose and Description
Playback Speed Adjusts the speed that the recording plays at.    The options are:

Slow: Plays at 25% of the original recorded speed

Normal: Plays at the same speed that it was recorded

Fast: Plays at 15x of the original recorded speed

As Fast As Possible: Plays as fast as your computer will take 
the commands

The factors that are listed above can be modified in the 
Advanced Options screen.    This allows you to set the Slow 
speed to play at something different than 25%, for example, 
50%.

Be cautious of the As Fast As Possible option, since it may 
not give your actions enough time to play back before the next 
one begins.    This could be a problem if you are starting 
programs or switching between applications.    It is better to 
test recordings at the Normal speed first, then move up to 
Fast, and finally As Fast As Possible once you are sure that 
the computer can handle it.

Repeat Allows the playback to loop a certain number of times.    The 
acceptable values are 1 – 2 billion.    While looping your 
recording, the number of completed playbacks will display in 
the title bar of Tasker (“2 of 3 done for C:\MyTask.tsx…”).

You can use the up/down arrows to the right of the Repeat box 
to change the number without typing in the box.

Continuous Indicates that the playback will not stop until you press 
“Control + Escape” (preferred) or “Ctrl + Alt + Del”.    If this 
option is checked, the Repeat value is grayed out and ignored, 
even if it lists a value.    Use this setting with caution by testing 
a recording a few times before allowing it to run Continuous.



Options Tab

Screen Item Purpose and Description
Always on Top Makes the Tasker window always visible and above all other 

windows.    If you start another program, the Tasker window will
remain above it.    This feature is useful for keeping Tasker 
visible while recording.    Changing this features immediately 
alters Tasker’s visibility, in other words, you do not need to 
restart Tasker for the change to take effect.    This setting is 
helpful when combined with the View – Show Tab Interface 
setting in the View Menu.    This setting has no effect when 
Tasker is only running in the System Tray.

Reload last saved file 
on startup This option tells Tasker to load the last file that opened in its 

previous session.    If you used a file called “MyEmail.TSX” and 
then shut Tasker down, when you start it again it will reload 
“MyEmail.TSX” (but will not run it until you press Play or 
enable the “Immediately…” option listed next).

Immediately play after 
File Open This will automatically press the Play button when you open a 

file through the File Open menu command.    Use this setting 
with care, since you may not want all files to instantly play 
when they are opened.    However, this feature can be 
productive when you use it to automatically and quickly run 
files that are in your Recent File List.

Auto-Start Tasker
with Windows When this feature is selected, Tasker will launch itself each time

you login to Windows.    This preference is useful because you 
do not have to manually start Tasker each time you turn on 
your PC.    This feature is especially helpful when you choose the
Tray Icon option on the Keyboard Tab.

Advanced Options… This button brings up the Advanced Options screen where 
you can modify additional settings for Tasker.    You should only 
use this feature if you are an advanced user of Tasker, since 
changing some of these settings may adversely affect your 
computer’s performance.





Keyboard Tab

The Keyboard Mappings and ShortType features allow you to use the keyboard to launch
macros, create new recordings, and automatically type for you.    These capabilities make 
Tasker an extremely powerful tool for automating work on your computer.

Keyboard Mappings are commonly used to start and stop recordings while working in 
other programs.    For example, you might map "Ctrl + Shift + R" to start a recording, 
"Break" to stop recording, and "F5" to play.    While typing in a program such as Word, you 
could press Ctrl + Shift + R and begin recording, and press Break to stop.    Then you press 
F5 and your recording will play back - all without ever switching to the Tasker window.    This
gives you the power to have the same macro key combinations work in every program you 
use.

Screen Item Purpose and Description
Keys Identifies what the special keyboard combination is that will be 

mapped to an action.    To select a new keyboard combination, 
click with the mouse in the field, then press keys on your 
keyboard.    When you type, the key names should appear in 
the field.    For example, if you type Control, then Shift, then 
“R”, a display similar to the image above will appear.    You can 
type keys one at a time: press and release Control, then press 
and release Shift, and they will still appear as “Ctrl + Shift”.    
However, when typing these keys after they are mapped, you 
need to actually hold each one down as the next one is typed.    
Also be cautious of choosing special Windows combinations, for 
example, “Alt + F4” is a special combination for closing a 
program, and “Ctrl + C” is used for copying to the clipboard in 
Windows.    If you map these combinations, they will not be 
passed to Windows for processing once the action assigned to 
them is started.

You can save multiple key combinations for a single action.    
This means you can have Ctrl + F6 and Ctrl + F7 both mapped 
to Start Recording.

Action Selects the event that you want to perform when the keyboard 
combination is typed.    There are three basic types of 
commands: Tasker recording controls, commands requiring
text, and replacement commands.



The Tasker recording controls are functions that control 
Tasker functions such as Start Recording, Stop Recording, and 
Playback.    They work the same as the toolbar recording 
buttons in Tasker.    See the Recorder Menu for additional 
information.

The replacement commands are single keys that are recorded 
normally, but are substituted during playback for something 
else.    Thus, they function as a placeholder.    For example, 
you might press the F8 key during recording, but for playback 
you can mark the F8 key to be a signal to type a random 
number (instead of pressing the F8 key).    This feature is useful
for entering dynamic data during playback, such as when you 
are creating unique records in a database.    It is the only way 
to generate dynamic entries during a playback without writing a
Tasker Script file.    Another interesting advantage is the ability 
to change the replace option as many times as you wish after 
the recording is made – you could change from a random 
number to a playback loop number without re-recording the 
placeholder signal key.

Text Field The commands requiring text (such as “Type the text”, 
“Launch the Program”, and “Play the recorded file”) are able to 
automatically type something or launch a program.    They use 
the text that you enter in the large box at the bottom of the 
screen.    Depending on which option you chose, some mapping 
commands either type what you entered or start the program 
that you listed.    To run a program or recording, it is helpful to 
include the entire path for the file, such as “C:\Program Files\
Some Application\RunThis.exe”.    This field can contain multiple
lines and is limited to 256 characters.

Activate This on/off checkbox manages Tasker’s ability to watch for the 
special key combinations that you entered in the Keys field.    
NOTE:   Keyboard Mappings and ShortType entries are   
both enabled or disabled by this switch.    To use 
Mappings or ShortTypes, this option must be checked.

If the Activate service causes any problems on your computer, 
you should disable it by unchecking this option.

NOTE: If you are Recording or doing a Playback, the 
keyboard services (Mappings and ShortType) will not 
work and will be temporarily disabled until the recording 
is completed.    This is by design.    This means that you 
cannot put a ShortType abbreviation in the Text field for a 
Keyboard Mapping.

Tray Icon The Tray Icon feature allows Tasker to run as an invisible 
“service” in the Windows system tray.    In this mode, the Tasker
window will not be visible, but you can still use Keyboard 
Mappings and ShortTypes (if Activate is checked) and Tasker 
will execute them.



The advantage of this feature is that you will not need to switch to the Tasker 
window to run recordings, and its window will not take up any screen space.    For example, 
once you set Start Recording, Stop Recording, and Playback mappings, you can work in 
Microsoft Word and start recordings and playbacks on-the-fly with Tasker, and you never 
have to leave your Word document.

 Button This button adds the Key and Action mapping record from the fields on the 
screen.    If any information is missing, Tasker will prompt you to complete the mapping 
before adding it.    If a mapping already exists for the key combination that you chose, 
Tasker will verify that you want to overwrite the old one with a new mapping.    This has the 
same effect as a modify feature.

 Button This button deletes the Key and Action mapping record that is listed in the 
fields on the screen.    There is no verification that before the record is deleted.    Also, there 
is no “undelete” capability.

 Button This button displays    additional help for using Keyboard Mappings and 
ShortType (this help file).



ShortType Tab

The Keyboard Mappings and ShortType features allow you to use the keyboard to launch
macros, create new recordings, and automatically type for you.    These capabilities make 
Tasker an extremely powerful tool for automating work on your computer.

The ShortType feature is used to help you type more quickly by replacing a character 
sequence with longer text.    For example, if you type the word "Sincerely" many times each 
day, it would be more efficient to simply type "xsig" and have the computer type 
"Sincerely".    Since "xsig" is not normally used while typing, it is a good choice for a 
shortcut abbreviation sequence.

Screen Item Purpose and Description
Replace Identifies what the special text will signal Tasker to 

automatically type alternate text.  Be careful not to choose a 
Replace text that is commonly typed.    For example, do not 
choose to replace “si” with “Sincerely” since the letters “si” 
occur in many other words (like “since”).    “xsi” or “1si” would 
be better choices.    The Replace abbreviation is limited to 
seven (7) characters, and can only contain lowercase 
letters (a-z), numbers (0-9), or spaces (' ').    For the 
current version of Tasker, a maximum of 64 ShortTypes can be 
saved (it would be difficult to remember more abbreviations 
than that).

Replace…with Indicates the text that you want Tasker to type once the 
Replace text is entered.    Tasker will completely remove the 
text from the Replace entry and type this text string.    This text
can be any character and contain multiple lines.    The text is 
limited to 256 characters.

Activate This on/off checkbox manages Tasker’s ability to watch for the 
special key combinations that you entered in the Keys field.    
NOTE:   Keyboard Mappings and ShortType entries are   
both enabled or disabled by this switch.    To use 
Mappings or ShortTypes, this option must be checked.

If the Activate service causes any problems on your computer, 
you should disable it by unchecking this option.

NOTE: If you are Recording or doing a Playback, the 



keyboard services (Mappings and ShortType) will not 
work and will be temporarily disabled until the recording 
is completed.    This is by design.    This means that you 
cannot put a ShortType abbreviation in the Text field for a 
Keyboard Mapping.

Tray Icon The Tray Icon feature allows Tasker to run as an invisible 
“service” in the system tray.    In this mode, the Tasker window 
will not be visible, but you can still use Keyboard Mappings and 
ShortTypes (if Activate is checked) and Tasker will execute 
them.

The advantage of this feature is that you will not need to switch to the Tasker 
window to run recordings, and its window will not take up any screen space.    For example, 
once you set Start Recording, Stop Recording, and Playback mappings, you can work in 
Microsoft Word and start recordings and playbacks on-the-fly with Tasker, and you never 
have to leave your Word document.

 Button This button adds the ShortType record from the fields on the screen.    If any 
information is missing, Tasker will prompt you to complete the ShortType before adding it.    
If a ShortType already exists for the Replace text that you chose, Tasker will verify that you 
want to overwrite the old ShortType with a new one.    This has the same effect as a modify
feature.

 Button This button deletes the ShortType record that is listed in the fields on the 
screen.    There is no verification that before the record is deleted.    Also, there is no 
“undelete” capability.

 Button This button displays additional help for using Keyboard Mappings and 
ShortType (this help file).



Advanced Options - Behavior

The Advanced Options screen allows you to change many features of Tasker that control 
its behavior and performance.    Only users who are experienced with Tasker should attempt 
to change these settings.    Some of the options, such as Log Settings, can negatively affect 
your computer's performance and should not normally be modified.

The screen picture above shows the screen with the normal settings.    The normal settings 
can be chosen with the Defaults button.

Screen Item Purpose and Description
Minimize Tasker when 
recording starts When this option is selected, the Tasker main window minimizes

as soon as you press the record or play button.    This permits 
you to start recording without the Tasker window getting in the 
way.    As soon as you stop recording by clicking on the Tasker 
minimized icon or by pressing the key that you have mapped to
Stop Recording (See Keyboard Mappings), the Tasker window
will automatically restore itself to its previous position on the 
screen.    This option has no effect if you have the Tray Icon 
option enabled.

Don't record actions for 
the Tasker window Indicates that the mouse clicks, key presses, etc, that occur in 

Tasker while you are recording will be ignored. Normally, you 
want this leave this checked for ON otherwise the mouse clicks 
for Tasker may end up going to another window during 
playback.    Actions that you perform in the Tasker window will 
still have their normal effect, but this setting ensures that those
actions will not go to a different window during playback.

Show warning when Windows 
interrupts Tasker Microsoft Windows may occasionally interrupt a Tasker 

recording or playback.    Some of the reasons why this might 
happen are if you press the Ctrl + Alt + Del or if you want to 



shut down your computer.    This setting instructs Tasker to 
show a warning that the recording /playback has terminated.    
This setting should normally be left checked (ON).

Show Tasker verification prompts
This setting indicates to Tasker whether you want it to ask for 
verification and show warning messages for various system 
actions, such as: verifying that you do not want to save a 
recording when you close Tasker, overwriting a previously 
existing file, or showing the system tray location when Tray 
Icon is chosen.    There are many such actions that normally 
require the user’s approval before continuing, but it is not 
feasible to list all the messages here.    This setting should only 
be turned off once you have used Tasker for a long period of 
time and are familiar with its behavior.    Unless you are an 
advanced user who completely understands Tasker, you will 
normally want to set this to ON (checked).

Quit Tasker when 
playback done With this chosen, Tasker will close after the first time that you 

play a recording.    This would be useful if you normally run a 
quick macro and do not want to switch to Tasker to close it 
afterwards.    When you directly run a recorded file by double-
clicking on it, Tasker will close automatically and will ignore this
setting.

Stop script execution 
when an error occurs If you are running a script and an error is encountered, Tasker 

will warn you with a message, stop the playback, and log the 
details in a file.    If you would rather have Tasker continue even
if an error occurs, uncheck this option.    Any errors that occur 
will still be logged in the log file.

Remember the previous session's 
playback settings With this option selected, the Speed, Loops, Continuous 

settings will be saved when you close Tasker and reloaded each 
time it starts up.    If this option is not selected, these settings 
will be the defaults (Normal Speed, 1 Repeat, Not Continuous).

Play Keyboard Mappings 
at fast speed When you have key combinations mapped to Start Recording 

and Playback, this setting will make the recording play at As 
Fast As Possible speed no matter what your Speed is set to 
on the first tab (Playback Tab).    For example, if you are in 
Microsoft Word and want to record yourself typing, you would 
not want to see the playback occur at the same speed that you 
recorded it with all the pauses included, but rather just the 
results of your typing.

Text Editor This setting allows you to choose an editor for text files.    The 
default editor is Notepad (notepad.exe), but you can choose 
any program that you like.    Use the  button to select the 
program so that the entire directory path is included.



Advanced Options – Value Ranges

Screen Item Purpose and Description
Fast Playback Factor This option sets the playback speed ratio when the Fast option 

is chosen on the first screen (Playback Tab).    It is a speed ratio
of the original recording speed.    Therefore, if you enter “20” 
for this value, a fast speed playback will move at approximately
2000% of the speed that it was recorded at (20 times as fast).   
The default value for this option is 15x (1500%).    You might 
want to change it to suit your needs depending on your 
computer’s performance.

Slow Playback Factor This option sets the playback speed ratio when the Slow option
is chosen on the first screen (Playback Tab).    It is the speed 
ratio of the original recording speed.    Therefore, if you enter 
“8” for this value, a slow speed playback will move at 
approximately 12% of the speed that it was recorded at (1/8 as
fast).    The default value for this option is 4x (25%).    You 
might want to change it to suit your needs depending on your 
computer’s performance.

Minimum Random 
Number In the third main screen (Keyboard Mappings Tab), you can 

choose a key to be a placeholder during recordings so that 
another text entry is made during playback.    One of the 
replacement text options is a random number.    This option 
sets the lower limit of the random number.    For example, if you
want your random numbers to be between 1 and 100, you 
would set this number to 1.

Maximum Random 
Number In the third main screen (Keyboard Mappings Tab), you can 

choose a key to be a placeholder during recordings so that 
another text entry is made during playback.    One of the 
replacement text options is a random number.    This option 
sets the upper limit of the random number.    For example, if 



you want your random numbers to be between 1 and 100, you 
would set this number to 100.

When typing "Playback Loop 
Number", add to loop # In the third main screen (Mappings Tab), you can choose a 

key to be a placeholder during recordings so that another text 
entry is made during playback.    One of the replacement text 
options is the playback loop number, which is incremented 
after every playback loop is completed.    This option adds a 
specified base number to the playback loop.    For example, if 
you want the recording to loop 10 times and have it type the 
numbers 2000 – 2010, you would set this option to “1999” and 
choose Repeat “10” times on the first screen (Playback Tab). 
When the playback begins to loop, the first number will be 
“2000” (1 + 1999), then “2001” (2+1999) and will continue 
until it loops ten times.

Recent File List By default, the Recent File List in the File Menu can contain up 
to a maximum of 8 entries.    This list will let you easily select a 
recording or script file that you previously worked on.    If you 
would prefer to have the list be shorter, you can adjust this 
setting.    Most programs place four recent files in the list.    This 
value can be anywhere from 1 to 8.    The up/down arrows allow
you to change the value without typing anything.

User Toolbar Button One of the buttons on the toolbar is dedicated you’re your 
choice of commands.    The button is yellow person-looking icon 
near the right side of the toolbar:

When this button is pressed, it will perform an option that you can choose.    This 
ability allows you to quickly access your favorite function in Tasker.    For example, if you are 
testing a script file, you may want to rapidly reload the file after you make changes to it, so 
you could choose the “Reload Current File” option.    Or, you might find it easier to use this
button to jump to the Advanced Options screen to change settings.    The available options
are:

· Playback - Use Fast Playback Speed 
· Options - Toggle Always on top 
· File - Reload Current File 
· Recorder - Use Normal Play Configuration 
· View - Toggle Tab Interface 
· View - Total Number of Actions 
· Tools - Edit Script File 
· Tools - Edit Log File 
· Tools - Backup All Settings 
· Tools - Backup Basic Configuration 
· Tools - Backup Mappings 
· Tools - Backup ShortTypes 
· Tools - Advanced Options Screen 
· Help - Help File Contents 



· Help - Script Reference 
· Help - Revision History 
· Help - Tasker FAQ 

All of these options are accessible via alternative methods in 
the Tasker program.    Commands that are already on the 
toolbar (such as Record and Play) were not included as choices 
for the User Command button to avoid redundancy.



Advanced Options – Log Settings

Screen Item Purpose and Description
Log Settings Level This control moves vertically and allows you to visually see 

what the current log level is.    The Log file is a special text file 
that Tasker uses to output information while running.    This file 
is helpful for locating a problem with Tasker because it will show
you every assumption is made during recordings and playbacks.
Additionally, any inconsistencies that Tasker finds will be listed 
in the log file (such as a memory error or a program that closed
unexpectedly).    There are four levels of logging:

HIGH Everything is logged, even technical details that would be of 
little use to anyone but the Tasker programmers at Vista 
Software.    This setting was left in for users so that they could 
see the internal decisions of Tasker in the event that it helps 
them to fix a problem.    It also helps Vista Software support 
technicians to fix a problem on a user’s computer without 
actually being there.    NOTE: The HIGH setting could 
dramatically affect performance of your computer, since many 
entries may be logged per second!    This setting should be used
rarely, if ever.    If the log level is set to HIGH or MEDIUM, a 
warning about performance will appear when Tasker is started.

MEDIUM This setting tracks individual actions (events) during a 
recording and playback.    This could result in many entries – 
each fraction of a mouse movement will be recorded, and a 
long mouse movement can result in hundreds of entries.    If the
log level is set to HIGH or MEDIUM, a warning about 
performance will appear when Tasker is started.

LOW The LOW log level will only track recording/playback starts and 
completions, and any errors that occur.    This level is very 
helpful because you will easily be able to see any errors that 
occurred without too much additional information in the way.

OFF This log setting records nothing, not even errors, and no log file



is created.    Tasker should be operated in this mode under 
normal circumstances.

Log File This field allows you to choose which file to use for logging 
information and errors.    The normal log file name is C:\
Tasker.log.    You can choose an existing filename with the  
button, but be aware that the chosen file will be erased and 
overwritten by Tasker.

Erase old log when 
Tasker starts If this option is checked, the previous log file is erased when 

Tasker starts up (if it exists).    This is useful to prevent the 
Tasker log from growing too large.    Normally, you will want this
selected even if you are using the log, since any errors that you
want to track will have occurred in the most recent session.



Advanced Options – Mouse Coordinates

Screen Item Purpose and Description
Mouse Hotlink The purpose of this screen is to determine what coordinates 

you want to use when writing a Tasker Script file.    For 
example, if you want to use script to make the mouse to click 
on a toolbar button (such as the Send Mail button in Outlook), 
you need to determine the X and Y coordinates.    Using this 
screen, you click AND HOLD the left mouse button on the icon 
image of the mouse with the dotted line around it:

Then, the image will change to a new icon:

…indicating that mouse tracking is active.    Then without 
releasing the mouse button, move around the screen and the 
informational window in the middle of this screen will show you 
the relative coordinates (“Window Title”) and the absolute 
coordinates (“Screen coordinates”) under the mouse cursor:

Ignore child windows 
(buttons, etc.) While tracking the mouse, this option limits windows to 

programs and pop-up windows.    In Microsoft Windows, all 
controls, such as buttons, are technically also “windows”, but 



are not usually targets for program macros.    However, if you 
turn this feature OFF (unchecked), every control will report its 
coordinates to you in the informational window.

Copy window title and script 
template to Clipboard This checkbox allows you to directly copy the resulting window 

coordinates into a Tasker Script file once you release the left 
mouse button.    This saves you from having to manually type 
the coordinates in a script file.    It also helps you to remember 
to use the GOTO command before using the CLICK command so
that the correct window is used during playback.    The output 
will be something like:

GOTO TaskerGuide.RTF - Microsoft Word
CLICK 68, 60

These two command lines can then be pasted into a script file 
and run.    (The example above will mouse click on the “Save” 
button in Microsoft Windows).

No matter where the Microsoft Word window moves to, the 
above script lines will always succeed in pressing the right 
button because the coordinates are relative to the upper left 
corner of the window.

As a safety feature, this checkbox always initially displays 
unchecked so that you do not inadvertently overwrite 
whatever is currently in the clipboard.    You must check this 
every time this screen displays.



File Menu

Screen Item Purpose and Description
New Creates a blank recording, similar to a new document in a word 

editor.    Tasker will prompt you to save the current file if you 
have modified it, and then informs you to press the blue button 
to begin recording.    The New toolbar button  has the same 
effect as this menu command.

Open… Opens a previously recorded file (TSK) or a Tasker Script file (TSX).    Once 
opened, it is loaded into memory, but is not run until you press the Play button or have 
chosen the “Immediately play after File Open” in the second screen (the Options Tab).    
The Open toolbar button  has the same effect as this menu command.
Reload Current File Reloads the current file that you have open.    Tasker cannot 

automatically detect if a file has changed since it was last 
loaded, so this feature allows you to modify a script file and 
quickly reload it.    This has the same effect as choosing File – 
Open on the currently opened file.

Close Removes the currently loaded recording or script file from 
memory.    This command disables the Play button since there 
will be no recording in memory.

Save As… Requires Tasker to prompt you for a filename and then saves 
the recording with the name you provide.    This feature also 
allows you to make a copy of the current file by saving it under 
a different filename.    The toolbar button  has the same effect 
as this menu command.

If you enter a filename with an extension and choose a file format that is different, 
Tasker will ask you to clarify which file format you want to use.    For example, if you enter 
“MyFile.TSX” as a filename and the dropdown “Save as Type:” has Tasker Recording (TSK) 
format, you will need to pick which format is the desired one.

(There is no “Save” file command since recordings cannot be 
modified once they are created.    Any change to a recording 
causes a completely new recording to be made - the old 
recording is overwritten in memory.    Therefore, re-saving a 
previous recording is not a possibility.    Script files are not 
affected by this design since they are modified in a text editor 
that is separate from Tasker.)

Reset Recent Files This command allows you to remove all files that are currently 
listed in the Recent File list (which appear immediately below 
this command in the menu).    The reason that you would want 



to do this is to clean up the menu and not have your previous 
recordings available on the File menu.    The actual files 
themselves are not modified in any way.

“Filename1-8.tsx” Each of the files recently opened will appear on the menu, up to
a total of the eight most recent files.    As soon as you open a 
new file, it will move to the top of the list and all the other 
recent files will move down one position.    This recent list can 
be a great time saver to avoid finding files that are located in 
folders inside of your computer.    Clicking on any of these files 
has the same effect as the File – Open command.    You can 
modify how many of these files appear in the Advanced Options
– Value Ranges Tab.

Exit Closes the Tasker window and leaves the program.    If the Tray
Icon option is selected, Tasker continues to run on the 
Windows system tray.



Recorder Menu

Screen Item Purpose and Description
Start Recording Starts recording your keyboard and mouse actions.    It will 

overwrite any other recording that you have in memory, but 
you will not lose the current recording if it was previously saved
as a file.    The Start Recording toolbar button  has the same 
effect as this menu command.    Also see Keyboard Mappings 
for a way to start recordings without switching to the Tasker 
window.

Stop Recording Stops a recording that is currently in progress.    This command will 
only be available while you are recording.    Stopping a playback is not possible with this 
option – you should use the Control + Escape key combination.    Once stopped, the Play 
button becomes active.    The Start Recording toolbar button  has the same effect as this 
menu command.    Also see Keyboard Mappings for a way to stop recordings without 
switching to the Tasker window.
Playback Plays a recording or script file.    This command is not available 

until there is a recording loaded in memory, which is 
accomplished with the File – Open command, loading a recent 
file, or by recording some actions.    The Playback toolbar button

 has the same effect as this menu command.    Also see 
Keyboard Mappings for a way to play without switching to the
Tasker window.

Load Normal Play 
Settings Instructs Tasker to set all play configurations (Speed, Repeats, 

and Continuous) to the Normal configuration.    This is the same
as Normal Speed, 1 Loop, and Not Continuous.    The reason for 
this command is to quickly set the playback options, and also to
allow linking the User Command  to this option for quick 
configuration switches.



View Menu

Screen Item Purpose and Description
Show Tab Interface Hides or shows the tab area of the Tasker window, depending 

on its currently visibility.    This allows you to minimize the 
space that the Tasker window takes on the desktop in case you 
have the Always on Top option chosen.    With the tabs 
hidden, you can still start, stop, and play recordings and choose
all the menu items.    The window will appear as:

Display Number of 
Actions This command shows the total number of events that are 

contained in the current recording.    Each fraction of a second a
new mouse command is generated, so this number might be 
very high, depending on the amount of time that you were 
recording.    Each action takes 20 bytes to store in a file in the 
TSK binary format, and considerably more if stored in the TSX 
text format.    The maximum number of events/actions for a 
single recording is 32,768 (half of 64K).    If you have a 
recording that is longer than that, consider breaking it up into 
separate recordings.



Tools Menu

Screen Item Purpose and Description
Auto-Start Tasker 
with Windows When this feature is selected, Tasker will launch itself each time

you login to Windows.    This preference is useful because you 
do not have to manually start Tasker each time you turn on 
your PC.    This option is normally combined with the Tray Icon
feature to allow you to invisibly add a macro capability to every 
program that you use.    This command is also available on the 
Options Tab.

Create Executable 
Program With this command, you can create your own Windows 

programs that do not need Tasker to run.    This “mini-
compiler technology” is a very advanced feature, because 
you can compile a single-line script file into a native Windows 
application!    No additional components are needed for the 
created program to run since it is a stand-alone .EXE file.    A 
common use of this capability is to allow sharing of these 
programs with other people who do not have Tasker.    People 
who run compiled .EXE files do not need to buy a Tasker license
to run the program.    The Create Executable Program toolbar 
button  has the same effect as this menu command.    

Edit Script File This command allows you to quickly open the script file that 
you are previously loaded with the File – Open command.    The
program used for text editing is read from the Advanced 
Options screen and run with the current script file as a 
parameter.

Edit Log File This command allows you to quickly open the Tasker log file in 
a text editor.    The program used for text editing is read from 
the Advanced Options screen and run with the log file as a 
parameter.

Backup All Settings Generates a .REG format file (Registry File Format, version 
Win9x/NT4 for compatibility) for creating a copy of all 
configurations in Tasker.    This includes all options, settings, 
recent file links, Keyboard Mappings, and ShortTypes.    Once 
the backup is generated, you can reload all the settings at a 
future date by double-clicking on this file.

Backup Basic Settings Like the Backup All Settings command, this generates a .REG
format file that can be reloaded a future date by double-clicking



on it.    This setting specifically exports the basic settings, which
are all the checkboxes on the Tasker main screens and the 
Advanced Options tabs.

Backup Mappings Like the Backup All Settings command, this generates a .REG
format file that can be reloaded a future date by double-clicking
on it.    This setting specifically exports the Keyboard Mappings 
that you created.

Backup ShortTypes Like the Backup All Settings command, this generates a .REG
format file that can be reloaded a future date by double-clicking
on it.    This setting specifically exports the ShortTypes that you 
created.

Advanced Options This tool command takes you to the Advanced Options popup 
window, where you can adjust many of Tasker’s settings.    This 
is meant for advanced users and other people with experience 
with Tasker.



Help Menu

Screen Item Purpose and Description
Contents/Index Launches the main Tasker User’s Guide (this file).    It 

includes general information about the use of Tasker and it not 
too technical.    Most users should find answers to their basic 
questions in this help file.    It is in standard Windows .HLP 
(Help File) format.

Help For This Screen Provides context-sensitive help for the screen that is currently 
visible in Tasker.    It describes every control or option that is on 
the visible screen and why you would need to use it.

Script Reference Launches a file that contains documentation for the Tasker 
Script commands.    Using Tasker script is a very productive 
way to use Tasker and this file contains detailed descriptions 
and many examples that you can use.    This file is in HTML 
format and displays in your default Internet browser.

Revision History This file lists all the feature changes that have occurred 
during the development of Tasker.    It is useful for seeing what 
changes have transpired since the last version, or how long 
something has been included in Tasker.    Not every little thing 
gets into this file, since it is updated when time permits, but it 
is fairly comprehensive.    (It also serves to demonstrate the 
huge amount of work that goes into developing a software 
product!)    This file is in HTML format and displays in your 
default Internet browser.

Tasker FAQ Displays a list of Frequently Asked Questions, which are the 
most common questions that users have when using Tasker.    
Questions like “Why does Tasker seem to play too slowly/too 
fast?” or “How can I press Ctrl+S with Tasker script?” are 
answered here.    This document is regularly updated, and is 
available on the web at www.vista-software.com/taskerfaq.htm.
This file is in HTML format and displays in your default Internet 
browser.

Legal Agreement Shows the license agreement that you agreed to when installing
Tasker.    It answers legal questions concerning the use of 
Tasker.

Register Allows you to enter a Registration Number once you purchase 
Tasker, or displays the person who it is currently registered to if
a number was already entered.

Email Tech Support Quickly loads your default email program and creates a blank 



email addressed to support@vista-software.com, which is the 
Vista Software support address.    Vista Software usually 
answers within 24 hours.

Tasker on the Web Provides a quick link to the Tasker homepage at www.vista-
software.com/tasker.htm using your default Internet browser.

About Tasker Displays detailed information concerning the current version of 
Tasker that you have.    It also shows the registration 
information, build date/time, copyright information, and 
hotlinks to Vista Software websites and support emails.



Service Tray Menu

The Service Tray Menu appears when you click on the Tasker icon when the Tray Icon 
option is selected (located in the Keyboard Mappings or ShortType Tabs).    This menu 
shows various commands that are available while Tasker is running from the Windows 
system tray.

Screen Item Purpose and Description
Start Recording Same function as the Start Recording toolbar button .    It is 

only available if you are not currently recording or playing.

Stop Recording Same function as the Stop Recording toolbar button .    It is only 
available if you are currently recording.
Play Same function as the Playback toolbar button .    It is only available if you have 
recorded something or opened a file.
Start Keyboard Service This command changes between Start Keyboard Service and 
Stop Keyboard Service depending on the current status of the Tasker service.    If the service
is disabled, the small Tasker icon will be gray; otherwise it will be displayed in color.    This 
service can also be activated in the Keyboard Mappings or ShortType Tabs.
Show Tasker Shows the Tasker main window.    If the Tray Icon option is 

chosen in the Keyboard Mappings or ShortType Tabs, then 
the main Tasker window will disappear since it will be running in
the background and not visible.    If you need to change a 
setting or perform some other option in the main Tasker 
window, you can reshow Tasker with this command.    Once you 
close Tasker, it will not exit but return to the system tray until 
you either choose Exit Tasker or remove the check from the 
Tray Icon option.

Exit Tasker Closes the Tasker window and system tray icon.    No Tasker 
functions will be available until you restart Tasker.    This can 
also be accomplished by choosing Show Tasker from this 
menu, then removing the Tray Icon option, then closing 
Tasker.    The Exit Tasker command is preferred because next 
time Tasker starts it will continue to run in the Windows system 
tray.




